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Introduction
Welcome to Homeventory  -  The developers of Homeventory are experienced business systems
professionals who know the features that heavy-duty, professional business applications must have.  You'll
find those features in Homeventory.

Back in 1990 I developed the first version of Homeventory mostly to learn about programming the PC and
using dBase. Many different programming languages were utilized including Quicksilver and Clipper. In 1993
I became a member of the Association of Shareware Professionals (ASP) and have met a number of
shareware authors who have assisted me over the years. This program is being released as freeware just for
registering (no cost) as my way to thank the shareware community and the ASP.
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Who Should Use Homeventory?
Homeventory is for anyone who needs to maintain an accurate inventory of his or her household
possessions. Imagine if you to return home after vacation to find out your house had been in a major fire and
looted. Will you be able to identify all of your household goods and personal property?

A completed household inventory using Homeventory will insure you have a permanent record of your
household contents and personal property, identify items by serial numbers, and determine if you have
adequate insurance protection.

After you have completed your inventory, you may want to include photographs of each room or high value
items and organize your receipts. You should keep these items in a safe place away from your home, so they
will be available should you need them.

Remember that time spent on a good inventory could save you thousands of dollars if you have a loss. And,
please, after you have completed your inventory, have your insurance agent review it and make comments
and/or suggestions.

Although  you don't have to be a computer expert to use Homeventory, you should be familiar with the
following:

The Microsoft Windows/95 operating environment and conventions.
Use of a mouse
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HomeventoryTechnicalSupport
If you need telephone support, call (907) 522-4232.  Telephone support hours are from 6:00 p.m. to 10:00
p.m.  Monday through Friday Alaska standard time.

You may contact us via the Internet at sales-team@alpinesoft.com. When you contact technical support,
please provide your Homeventory serial number. You'll find your Homeventory Serial number located on the
back side of your distribution diskettes.
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Registering Homeventory
Unlocking the Program

This program is released as Shareware.
You may use this program for 60 days free as a trial.  Registration beyond the 60 day trial is FREE  for all
non commercial use and all it takes is a quick email to us (see below). After that time you are expected to
either register this program, or remove it from your computer.

What registering will get you:

• A registration code which will remove all the annoying "Shareware Reminder" Windows.
• Information on upgrades to Homeventory.  (For the foreseeable future, and probably forever, all

upgrades to Homeventory will be free to registered users.)
• A lifetime license to use Homeventory
• A warm fuzzy feeling that you did the right thing.
• The more people who register this shareware, the more incentive to make Homeventory even better.

Registration Options:

We only have one registration period. Please send an email to mailto:sales-team@alpinesoft.com giving us
your full name, address, phone numbers and valid email address at which time we will send to you by return
email a registration key that will unlock Homeventory for you to use forever.
After you have received your registration key using the Homeventory menus, select Registration Info, then
select Enter your Registration Number at which time the following screen will be displayed:
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Fill in your name and your number exactly as it appears on the email that was sent to you by alpine software.
After completed please accept Homeventory as a lifetime asset that will allow you to always organize your
possessions.

Homeventory Option Pak

As stated above, Homeventory is FREE just for registering the program. If you would like a copy of the
program on disk/CD, a professional printed copy of the user manual, and the Homeventory AddonPak
utilities (including database maintenance, and backup/restore) you may purchase the option for  $9.95 plus
$3.00 shipping and handling by sending us a request to:

Alpine Software
P.O. Box 212421
Anchorage, Alaska 99521-2421

Thank you for supporting shareware.  If you have questions or issues concerning Homeventory, please see
the Homeventory Technical Support section.

We realize that using a new program can be quite frustrating but you should find Homeventory quite easy-
user friendly to use. We have presented the information here in a top down format the should follow your
progress while you are using the program. Remember that should you need assistance email is always
available at mailto:support@alpinesoft.com. Other that we hope you enjoy the program.
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Getting Started
This chapter shows you how to SETUP Homeventory on your computer and how to run it.  When you're
ready to SETUP Homeventory, you'll need the Homeventory SETUP Disks.

The chapter concludes by pointing out some things that you should know to help you use Homeventory.
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Installing Homventory
This section shows you how to install and run Homeventory.

To install Homeventory on your computer you run the program SETUP.EXE on the Homeventory SETUP
Disk 1.

Important   You cannot simply copy files from the SETUP Disks to your hard disk.  You must use the
SETUP program to decompress and install the Homeventory  files in the Homeventory directories.
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Before You Begin Installation
Before you install Homeventory, make sure that your computer meets the minimum requirements.
Check the Hardware and System Requirements

To run Homeventory, your computer system must meet these requirements:

• Any IBM®-compatible computer with an 80486DX processor or higher.
• A mouse.
• 16 MB RAM.
• A hard disk with 3 megabytes of free space.
• A 3 1/2" floppy drive.
• VGA or higher resolution monitor (At least 800 x 600).
• Microsoft® Windows/95® (this is a requirement, this version WILL NOT run under Windows 3.x).
•I installed Windows fonts: Arial, Courier New and Times New Roman
•
Make Backup Copies of the SETUP Disks

Before you run Install, make backup copies of the Homeventory SETUP Disks.  Put your backup copies in a
safe place.
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Running Setup
Begin the Homeventory  installation process by running SETUP.EXE.  If you are installing from a floppy disk
drive other than A, adjust the instructions accordingly.

To run SETUP

1. Start Windows/95.  Close all other Windows applications.
2. Insert Homeventory  SETUP Disk 1 in drive A.
3. From the File menu of the Program Manager or File Manager, choose Run.
4. In the Command Line text box, type a:setup and click OK.
5. Install displays a dialog telling you that it will SETUP Homeventory in the c:\Homeventory directory,
or another directory of your choice.
6. Follow the instructions on the screen.
7. Install ends.
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What Setup Installs
Homeventory  Directories

Install creates a \Homeventory directory on your hard disk if it does not already exist with the following files:

File Description
HOMEV.EXE The main program
HOMEV.HLP Homeventory help file
HOMEINV.DBF
HOMEINV.FPT
HOMEINV.CDX Main inventory file and related index and memo file
ADDR.DBF
ADDR.CDX Name & Address book file and related index
CBOOK.DBF
CBOOK.FPT
CBOOK.CDX
CBOOKI.DBF
CBOOKI.CDX Recipe files and related index
VEHICLE.DBF
VEHICLE.CDX
VEHHIST.DBF
VEHHIST.FPT
VEHHIST.CDX Vehicle maintenance files and related index
CATEGORY.DBF 
CATEGORY.CDX Category lookup table and related index 
CONDITION.DBF
CONDITION.CDX Condition lookup table and related index
MFGR.DBF
MFGR.CDX Manufacturer lookup table and related index
ROOMS.DBF
ROOMS.CDX Rooms lookup table and related index
SOURCE.DBF
SOURCE.CDX Source lookup table and related index 
STATUS.DBF
STATUS.CDX Status lookup table and related index
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Running Homventory
From the Windows Program Manager start Homeventory by clicking on the Homeventory Icon.

Homeventory Version 3.1 / Alpine Software Page 11



Using Homeventory
We realize that using a new program can be quite frustrating but you should find Homeventory quite easy-
user friendly to use. We have presented the information here in a top down format that should follow your
progress while you are using the program. Remember that should you need assistance email is always
available at support-team@alpinesoft.com. Other than that we hope you enjoy the program.

Homeventory Version 3.1 / Alpine SoftwarePage 12



Main Screen
As you can see from the following screen shot all of the features of Homeventory are available from the main
screen.

The Homeventory menu and main screen offer many options. The following sections provide an overview of
each menu. Use these sections as a reference guide to the menu options.

More:

File Menu
Data MenuDataMenu>Main
Reports MenuReportsMenu>Main
Registration InfoRegistrationInfo>Main
Help MenuHelpMenu>Main
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File Menu
The following table briefly describes the File menu options.
File Menu
Option Purpose
Print Setup Change printer settings, printer, orientation, paper tray, etc.

Exit Closes Homeventory.
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Data Menu
The following table briefly describes the Data menu options.

Data Menu
Option Purpose
Home Inventory Add/change/delete information in the inventory file.

Category Lookup Table Maintain the category lookup table.

Room Lookup Table Maintain the room lookup table.

Status Lookup Table Maintain the status lookup table.

Manufacturer Lookup Table Maintain the manufacturer lookup table.

Place of Purchase Lookup Table Maintain the place of purchase lookup table.
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Reports Menu
The following table briefly describes the Reports menu options.

Reports Menu
Option Purpose
Report Selection Selects the dialog of "canned" reports that are included with Homeventory.

Report Generator Selects the report generator which will allow you to create reports and labels in any
format that you require.
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Registration Info
The following table briefly describes the Registration Info menu options. Notice that this menu option will not
be displayed after the program has been registered.

Registration Info Menu
Option Purpose
How to RegisterThis item brings up the help window that will guide you through the registration process
Enter your Registration Number After you have completed your registration with Alpine Software you will be
sent a registration that you enter using this menu item. Once you have registered the program these menus
will disappear.
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Help Menu
The  Help menu contains options for accessing Homeventory Help

The following table briefly describes the Help menu options.

Help Menu
Option Purpose
Contents... Displays the main topics in the Homeventory Help file.

About Displays information about Homeventory
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Toolbar Controls
The Homeventory Toolbar provides controls that let you view and manage the data in the Homeventory
tables.
Homeventory toolbar controls let you navigate through the records, search for records, change the record
order, add records, delete records and save changes to records. The control buttons have pictures, or icons,
that represent their functions. The Homeventory controls are shown below.

Main Toolbar Controls

Homeventory Main Toolbar Controls

Picture Purpose

Closes all screens and returns to Windows (exit)/

Displays the Household Inventory screen

Displays the Vehicle Maintenance screen

Displays the Accounts Screen

Displays the Recipe (Cook Book) screen

Displays the Name and Address Screen

Displays the print selection screen for household inventory

DataBase Navigation Toolbar

Homeventory DataBase Navigation Toolbar Controls

Picture Control Purpose

First Displays the first record in a table as defined by the record Order and Filter.
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Prior Displays the previous record in a table as defined by the record Order and Filter.

Next Displays the next record in a table as defined by the record Order and Filter.

Last Displays the last record in a table as defined by the record Order and Filter.

New Displays blank form fields for adding a record to a table. If the form is a child in a Related
Forms group, the primary key fields in the parent record are automatically entered into the foreign key fields
of the new child record.

Delete Deletes the current record from the table.  Relational Integrity is enforced.

Post/Save Saves data entered while adding, Copying or editing a record and ends the add or
Copy.

Cancel edits Cancels data entries and changes made while Adding, Copying or editing a record
and terminates the Add or Copy.

RefreshRefreshes the current record.

Bookmark Allows you to set a bookmark, view a different record in the file and then go back to
the marked record.

Edit Brings up the edit screen for the current record

Filter Allows you to either view or print a subset of data based on some criteria. See the section on
"Filtering Data" following this section of the user's guide.

Close Closes the current window and takes you back to the previous window.
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Filtering Data
As you get more familiar with the software and you begin to add all of the information in you're your house
the data files can become quite large. Suppose you are working on your inventory for your Den. The filter
button located on either the Inventory browse screen or the report selection screen will allow you to only look
at data based on some criteria like ROOM = 'Den'

Pressing the Filter   button will display the following screen:

Filter Screen

The first thing you are thinking is "whew, this is too complicated". Well it is really not. In the above example I
first clicked on  "Room" under the Fields box which added the room field. I then entered "Den" in the Field
Value box.. For Search Type I selected the Partial Match at Beginning (this will only select records beginning
with the word Den like Den, Den Room, and so on). After you are finished entering filter conditions press the
OK button and the filter will be reset. After this screen closes you will only be looking at the information you
have filtered.

To clear a filter condition press, the filter button on the toolbar and then press and press the clear button.
This will clear out your filter condition.
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Lookup Fields
You will notice that on some of the fields in the edit screens there is a little box to the right of the field with an
arrow pointing down like the following status field:

These fields use lookup tables (described later) for field validation. In plain English you must have a record in
the corresponding table for this field to be valid. The following fields use this feature:

Category
Condition
Room
Status
Manufacturer
Purchased From
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Household Inventory
Data Entry

The Homeventory Browse screen is the first screen that will be displayed when you select Home Inventory
from the Main screen. From this screen you will be able to move up and down through the data base quickly
locating information in your inventory. You may either use the up and down arrow keys, or the Page Up or
Page Down keys or any combination.
You will also notice the record pointer (the little right pointing arrow) on the left hand side of the screen. This
arrow indicates the current record and when you press the EDIT button, that record will be displayed.

Home Inventory Browse Screen

Also on this browse screen, you will find a Record Order field used to help you navigate through the
inventory file:

Selecting any one of the popup values will change the order in which you are viewing your inventory file. In
the above example Inventory ID is the sort order.
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Home Inventory Edit
The Edit screen is used for all of the data entry functions including adding, changing (editing), or deleting
records.

Home Inventory Edit  Screen

You will also notice the following tabs on the screen used to enter different types of data:

The "Basic" tab is used for recording basic information about the item, the "Purchase/Replacement" tab is for
financial and replacement information, and finally the "Description" tab is where you can record any
additional information that might be important.

Displays the Category Lookup table so you may Add, Change, or Delete records.

Displays the Room Lookup table so you may Add, Change, or Delete records.
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Displays the Status Lookup table so you may Add, Change, or Delete records.

Displays the Manufacturer Lookup table so you may Add, Change, or Delete records.

Displays the Place of Purchase Lookup table so you may Add, Change, or Delete records.

Displays the Condition Lookup table so you may Add, Change, or Delete records.

Fields on the Basic Home Information tab:

• Inventory ID - this field is the unique number you assign to your item. It is used to quickly locate and
distinguish each item in the database.

• Category – The category field is used to group your possessions into logical groups mostly for sorting
purposes. There hare no hard and fast rules here but please use something you can understand. You
must have a corresponding entry in the Category Lookup table for this field to be valid. Consider the
following examples:

Furniture
Electronics
Computer
Tools
Jewelry

• Status –  The status field can be used to show you information such as "Sold", "On Loan", or other
information you require. You must have a corresponding entry in the Status Lookup table for this field to
be valid.

• Room –  Enter the room where this item is normally kept. You must have a corresponding entry in the
Room Lookup table for this field to be valid.

• Condition –  Enter the current condition of this item. You must have a corresponding entry in the
Condition Lookup table for this field to be valid.

• Manufacturer –  Enter the name of the manufacturer of the item. If you are unsure, you could enter
"Unknown".  You must have a corresponding entry in the Manufacturer Lookup table for this field to be
valid.

• Model – Enter a descriptive model term for this item.

• Model Number – If you know the model number enter, it in this field. If you do not have a model
number you, could  enter a descriptive term.

• Serial Number – If this item has a serial number, enter it here. If it does not have a serial number,
enter N/A. This will show you at a later time you made an entry for this field.
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Home Inventory Purchase/Replacement Tab

Fields on the Purchase/Replacement tab:

• Date Purchased – Enter the date this item was purchased or try to at least estimate the year you
purchased it.

• Receipt – Check this box if you have a receipt for this item. Warning: We suggest you store your
receipts in a safe location such as a safety deposit box.

• Insured – Check this box if this item is insured as a line item on an insurance policy.

• Place Purch – Enter the name of the company or the person where you purchased this item. You must
have a corresponding entry in the Purchased From Lookup table for this field to be valid.

• Ins Policy -  Enter the insurance policy number. You must have a corresponding entry in the
Accounts table for this field to be valid.

• Quantity –  Total number of pieces you have. For example if you have a collection of coins, create a
entry for each unique item and enter the number you posses here.
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• Value Each –  Unit value for a single item.

• Cost Each –  The price you paid for each item.

• Total Value –  Enter the total estimated value for this item.

• Total Cost –  Enter the total cost YOU paid for this item.

• Appraised Value – Either enter an actual appraised value or your estimated value for this item.

Home Inventory Description Tab

Fields on the Description tab:

• Description –  This field can be used to record any additional information you would like to note.
Specific condition of the item, history where it was purchased and who the prior owners were, etc.
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Vehicle Maintenance
Data Entry

The Vehicle Maintenance Browse screen is the first screen that will be displayed when you select Vehicle
Maintenance from the Main screen. From this screen you will be able to move up and down through the data
base quickly locating your vehicles. You may either use the up and down arrow keys, or the Page Up or Page
Down keys or any combination.
You will also notice the record pointer (the little right pointing arrow) on the left hand side of the screen. This
arrow indicates the current record and when you press the EDIT button that record will be displayed.

Vehicle Maintenance  Browse Screen

Homeventory Version 3.1 / Alpine SoftwarePage 28



Vehicle Maintenance  Basic Data Tab

Fields on the Vehicle Edit tab:

• Vehicle ID – Enter the Vehicle ID (VIN) number found on the vehicle.

• Description – Enter a general description of the vehicle

• Year – Year the vehicle was manufactured

• Make – Make/manufacturer of the vehicle

• Model – Model type or number

• Style – Style of vehicle, I.E. Coop, station wagon, etc.

• Color – Color scheme of the vehicle

• Insurance Policy - Enter the insurance policy number this vehicle is covered in. You must have a
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corresponding entry in the Accounts table for this field to be valid.

• Purchase Date – Enter the date you purchased this vehicle

• Purchase Cost – Enter the actual amount you paid for the vehicle. Remember, don't forget to add
interest.

• Purchase Place –  Enter the name of the company or the person where you purchased this item. You
must have a corresponding entry in the Purchased From Lookup table for this field to be valid.

• ODE -

This screen is used to record the cost of ownership for each vehicle. You may, if you desire, record all
expenses incurred while you own the vehicle, such as gas. There are no rules here, just what ever suits you.

Vehicle Maintenance Vehicle History Tab

Fields on the Vehicle History Tab:
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• Date – The date you incurred this item

• ODE – miles?

• Description – Brief description of this item

• Cost – Cost including tax.

• Category – The category field is used to group your maintenance items into logical groups mostly for
sorting purposes. There hare no hard and fast rules here but please use something you can understand.
You must have a corresponding entry in the Category Lookup table for this field to be valid.

• Additional Comments – Free form area to record any additional comments or notes about this
specific item.
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Accounts
Data Entry

The Accounts  screen is the first screen that will be displayed when you select Accounts from the Main
screen. From this screen you will be able to move up and down through the data base quickly locating your
accounts. You may either use the up and down arrow keys, or the Page Up or Page Down keys or any
combination.

You will also notice the record pointer (the little right pointing arrow) on the left hand side of the screen. This
arrow indicates the current record and when you press the EDIT button that record will be displayed.

Accounts Screen

Fields on the Accounts Screen:

• Policy No –  Policy number. You should enter this number exactly as it appears on a statement or
credit card.

• Name –  Enter the name that is on the account, not necessarily your name.
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• Acct Type –  Used to categorize accounts. I.E. "Credit Card", "Insurance", "Utility", etc.

• Address Information – Address of this company.

• Phone –  Phone number including area code

• Fax –  Fax number including area code

• Email – Email address.
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Recipes
Data Entry

Back in the mid 70s our forefathers of the computer stated that one of the primary uses of the home
computer was to keep track of recipes. Hundreds of programs have been developed, some rather complex,
to record recipes. Homeventory has taken the simple approach to record basic recipe information. You can
also check our web site from time to time to get more recipes for your collection.

The Recipe Browse screen is the first screen that will be displayed when you select Recipes from the Main
screen. From this screen you will be able to move up and down through the data base quickly locating your
recipes. You may either use the up and down arrow keys, or the Page Up or Page Down keys or any
combination

You will notice the record pointer (the little right pointing arrow) on the left hand side of the screen. This arrow
indicates the current record and when you press the EDIT button that record will be displayed.

Recipes Browse Screen
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The Recipe Edit screen is used to record all information about your recipes.

Recipes Edit  Screen

•Recipe ID – The recipe ID field is used to uniquely identify each of your recipes. This number will be
assigned for you by the software.

•Title – Enter a brief title for your recipe

•Category – This subject could be a big debate among the cooking culture. Please use category to group
YOUR recipes into different groups that you can easily find. For example: "Holiday, Main Dish", "Dessert",
etc.

•Prep Time – There are no formatting rules here. Just enter the time needed to prepare this recipe.

•Yield – How much/many this recipe will produce. I.E. "3dz cookies", "12 lbs.", or "Serves 12".

•Contributor – Where you got this recipe from. I.E. "Mother"
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Entering individual ingredients. Enter as many ingredients as the recipe calls for. Information for using the
navigation buttons can be found earlier in this documentation

To add ingredients, press the ADD button and enter information directly into the grid.

The last step entering a recipe is to record the directions for preparing. The following area on this screen us
used for this purpose:

You can enter information directly into this area or using your mouse press the right button any the following
pop-up menu will appear giving you formatting options:

Most of the menu options are pretty much straight forward and follow normal window conventions. If you
press the "Edit" menu item the following word processor like screen will appear giving you full control for
editing directions:

Homeventory Version 3.1 / Alpine SoftwarePage 36



Edit Recipe Directions Screen
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Name and Addresses
Data Entry

It seems that everyone has a computerized address book these days and you ask why? And we say why not?
The Address Book is just another optional feature you may either choose to use or not. What is unique about
ours is the ability to record additional information not found in others.

The Name and Address Browse screen is the first screen that will be displayed when you select People
(Address)  from the Main screen. From this screen you will be able to move up and down through the data
base quickly locating people. You may either use the up and down arrow keys, or the Page Up or Page Down
keys or any combination.

You will notice the record pointer (the little right pointing arrow) on the left hand side of the screen. This arrow
indicates the current record and when you press the EDIT button that record will be displayed.

Name and Address Screen (Basic Data Tab)

Homeventory Version 3.1 / Alpine SoftwarePage 38



Fields on the Basic Data tab screen:

• First Name – First name

• Last Name – last name

• Nick Name – Any other name you use to identify this person

• Address – 2 lines are provided to enter a complete address

• City ST Zip – City, State, and zip (postal) code

• Country - Country

• Home Phone – Home phone including area code

• Work Phone – Work phone including area code (aaa) ppp-pppp

• Work Ext. – Work extension

• Fax Number -  Fax number

The Additional Data tab screen is used to record more personal information.

Name and Address Screen (Additional Data Tab)

Fields on the Additional Data tab screen:

• Email Address – Email address

• Children –  Children's name
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• Hobbies –  Any hobbies this person might have

• Health Issues – Any health issues this person might have

• Birth Date – Birth date

• Anniversary –  Anniversary date

• Send Birthday Card – Check this box to indicate to send a birthday card (You can use the Report
generator to either print a report or print label for people you want to send birthday cards to).

• Send Anniversary Card - Check this box to indicate to send a anniversary card (You can use the
Report generator to either print a report or print label for people you want to send anniversary cards to).

Holiday Cards tab screen is used to track re-occurring  holiday cards. Information for using the navigation
buttons can be found earlier in this documentation

Name and Address Screen (Holiday Cards Tab)

Fields on the Holiday Cards Tab:

• Year –  Enter the year for this exchange

• Send card for this year – If you want to send a card check this box

• Received card this year – If you received a card this year check this box

The Notes tab screen can used to enter any other additional information not covered using standard fields
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Name and Address Screen (Notes Tab)
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Lookup Tables
Category Lookup Table

The Category Lookup table is used to group items into different logical groups mostly for reporting purposes.
There are no hard and fast rules here, just try to develop categories that make sense to you.

Category Lookup Table Screen

Examples of categories:

Furniture
Electronics
Computer
Tools

      Jewelry
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Condition Lookup Table
The Condition Lookup table is used to record the current condition of an item.. There are no hard and fast
rules here, just remember that if you have a loss your insurance will want to know the condition of an item
that is to be replaced..

Condition Lookup Table Screen

Examples of Condition:

Excellent
Fair
Good
Mint
Poor
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Room Lookup Table
Make one entry for each room in your house. You might also consider creating rooms for locations other that
your house like: On Loan, Office, etc.

Room Lookup Table Screen

Examples of Rooms:

Living
Kitchen
Den
Bedroom 1
Master Bedroom
Garage
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Status Lookup Table
The status lookup table is used to distinguish a status attribute for the item such as In Use, On Loan, Sold,
Borrowed, etc.

Status Lookup Table Screen

Examples of Status:

In Use
On Loan
Sold
Want
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Manufacturer Lookup Table
Record an entry for each manufacturer you have. Also create a dummy entry for manufacturers that are
unknown.

Manufacturer Lookup Table Screen
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Place of Purchase Lookup Table
Record an entry for each establishment you have purchased goods from. Also create a dummy entry for
places that are unknown.

Place of Purchase  Lookup Table Screen
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Report Selection
Producing Standard Reports

This menu option will allow you to either print the predefined reports or use the end user report tool to design
and print reports or labels on your own format.

Select Reports from the main menu bar:

The report selection menu item will bring up the report election dialog. The Report Generator menu item will
bring up the end user report generator (please see the additional help for this feature)
The report selection screen will appear as follows:

Report Selection Screen

Using the mouse select one of the six standard reports and either press the "Preview Report" or "Print
Report" button to continue. The "Print" button will immediately print the report where the "Preview" button will
open up a screen for viewing before you print.

When you have selected "Preview", a screen will be displayed with the following tool bar at the top of the
screen:
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Report Toolbar Controls
Picture Purpose
Control

Zoom to Fit Will fit the entire report into your screen.

Zoom to 100% Zooms the report to 100% which will allow you better visibility.

Zoom to Page Width Will show the full width of the report. Use the up and down  elevator
button to navigate.

First Page Displays the first page of the report.

Prior Page Displays the previous page of the report.

Next Page Displays the next page of the report.

Last Page Displays the last of the report.

Printer Setup Displays the printer setup dialog. 

Print Print the report in the window.

Save to File Use the option to save the entire contents of this report for later use. The
load report button may be used to retrieve the report at a later time.

Load Report Use this button to load a previously saved report.

Close Close the report dialog.
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